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Organisations in virtually every industry sector rely on their IT systems to conduct business. The IT department’s 
ability to resolve technology issues and manage the ever-changing IT infrastructure is critical to support business 
goals. Bellerophon Helpdesk automates many aspects of call management, increasing efficiency which allows staff to 
focus on problem resolution. The solution is easy to deploy, in days, not weeks - and is affordable for organisations 
that need a quick start in service management. 

BELLEROPHON HD is built on the same BELLEROPHON EMS II platform as our more comprehensive enterprise 
solution, Organisations that have a helpdesk requirement today can be confident of investing in a solution that can 
grow as business needs change. 

 
BELLEROPHON HD Helpdesk software automates many aspects of call and trouble ticket management, increasing 
efficiency, and allowing the help desk to focus on support & problem resolution. 

In order for today's businesses and organizations to maintain and improve customer service and optimize help desk 
staffing levels your help desk software must help you create... an efficient, cost effective customer focused 
support environment!  

 
Whether you currently track support requests on paper or spreadsheet, or have help desk software that is no longer 
adequate for your current needs, we invite you to take a look at our Bellerophon HD Help Desk Software which 
enables you to provide a cost effective network based solution.  

 

Fully-automated call management, prioritization, ownership and audit trail.  

 

Fully-automated email integration with shared mailbox support.  

 

Resource scheduling and calendaring are standard.  

 

Knowledge Base for common problems and solutions.  

 

Full rights management to control the access and use of the solution by technicians 
and customers.  

 

Comprehensive reporting environment with graphics and real-time report options.  

 

Fast and easy to install, configure and deploy. 

 

Fully-customizable table schema and user interface  
 

Fast to Deploy, Easy to Configure 

Bellerophon HD Helpdesk software provides the optimum combination of call management automation, 
functionality and flexibility, delivering a comprehensive help desk solution that satisfies most  Helpdesk 
requirements right out of the box. Built on Bellerophon (Enterprise Support Platform), BELLEROPHON HD 
allows the customer to pick and choose the elements of the solution required to meet precise needs.  

Unlike other IT support software, BELLEROPHON HD is non-prescriptive and can be configured to meet additional 
business processes not strictly defined within a conventional IT Helpdesk environment, thus providing ultimate 
flexibility.  

Business Benefits 

 

Streamline and automate your customer service requests.  

 

Improve customer satisfaction.  

 

Increase the productivity of your IT support staff.  

 

Lower the cost of your IT support service.  

 

Reduce technician training time with a familiar look and feel.  

 

Easily integrate, out of the box, with many common Network and Desktop management solutions.  
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0. This Help Desk manual will give you an understanding of Bellerophon HD. The Help Desk can be divided into 

three categories, setup, functional and informational.  Here is a brief overview of how each section of the Help 

Desk fits into each of these categories. 

 
Setup 
 
The setup screens are where static information pathways are created in order that other screens can work 
correctly. These screens allow you to 

 Setup unique departments on individual helpdesks, with specific fields and data capture points per 
department.  

 Setup custom fields including, text boxes, picking lists, drop downs  

 User access per department, but I.T. departments can access each helpdesk  

 Setup and configuration of SLA’s based on selected custom fields 

 Configuration of departments including job completion targets and additional email footers 

 Enable or Disabled departments 
 

An example of these types of screen is Maintenance 
 

Functional  
 
The functional screens are where business process actions are carried out within the module. These screens 
allow you the 

 Jobs can be assigned to an individual and alerts and requests are sent via optional emails  

 Jobs can be updated and a full and complete audit trial is tagged to the job. This included information 
regarding what was done, the time it was carried out and by whom  

 Job’s can be reassigned back and forth to various people; the audit trail is updated automatically  

 The jobs can be filtered by both the standard fields and the custom user defined fields  

 Documents can be attached to individual jobs and can be retrieved at any time 
 
An example of these types of screen is Jobs 
 
Informational 
 
Finally, the informational screens are where data can be manipulated and viewed for managerial and analytical 

purposes. These screens allow 

 Statistical information about the success of failure of jobs completed in time.  

 Individual users can be monitored and their progress compared to others in a league table  

 Graphical charts depicting the percentage of jobs completed on time versus, overdue jobs and 
overdue jobs completed after the estimated due date has been changed to monitor anomalies.  

 Jobs can be plotted in an Outlook style calendar interface for easy viewing of the day, week or months 
tasks.  

 
Some examples of these types of screen are Scheduler and Management 
 
Unique Points about the Help Desk module are 
 

 The ability to completely customise the helpdesk and setup departmentally specific screens.  

 The helpdesk is linked into the system and users can directly log jobs without the need to call up in 
person 
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0.1 Installation 

 

0.1.1 Bellerophon HD installation 

 

Run Install.exe as administrator 

 In Windows Vista  Right click and click ‘Run as Administrator’ 

 In Windows XP  Right click and click ‘Run as...’ 

    Select the ‘The Following User’ radial selection 

    Enter the administrator log in details 

Accept that you wish to install Framework .net 3 and SQL Server 2005 Express 

Select a location to install to using the ‘Browse’ button 

Click the ‘Install’ button 

When it asks if you wish to install the application click on ‘Install’ again 

You should now see the log in screen 

Make sure the options are visible 

Place a tick next to ‘Change Server Name’ 

Enter MYCOMPUTER\SQLEXPRESS (where MYCOMPUTER is the name of your computer) 

Leave the Username and Password blank 

Click the ‘Login’ button 

When it asks if you wish to create the database as it doesn’t exist click yes 

When it returns to the login screen enter both the username and password as ‘argonaut’ and click ‘Login’ 

You should now be in ok 

 

0.1.2 Bellerophon HD Lite installation 

 

Run Install.exe as administrator 

 In Windows Vista  Right click and click ‘Run as Administrator’ 

 In Windows XP  Right click and click ‘Run as...’ 

    Select the ‘The Following User’ radial selection 

    Enter the administrator log in details 

Select a location to install to using the Browse button 

Click the ‘Install’ button 

When it asks if you wish to install the application click on ‘Install’ again 

You should now see the log in screen 

Make sure the options are visible 

Place a tick next to ‘Change Server Name’ 

Enter your SQL server name or the name of your SQL Express instance i.e. (MYCOMPUTER\SQLEXPRESS) 

Enter a username and password that has access on your SQL to create a database 

Click the ‘Login’ button 

When it asks if you wish to create the database as it doesn’t exist click yes 

When it returns to the login screen enter both the username and password as ‘argonaut’ and click ‘Login’ 

You should now be in ok 
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If you get the error unable to create registry keys or there are no options in the ‘Server Name’ and ‘DB 

Name’ drop down menus follow these steps first 

 

Open the ‘Helpdesk Key.reg’ file from the downloaded ZIP in notepad 

Replace ‘Enter your SQL server name here’ with your SQL Server name 

Replace ‘Enter your database name here’ with your chosen database name 

If you require multiple databases you need to enter the database names separated by commas 

(databse1,database2,database3,etc) 

Close and save the reg file making sure the file extension is still .reg 

Double click on the newly updated ‘Helpdesk Key.reg’ file to update your registry keys 

Try again and it should work fine now 
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0.2 Bellerophon HD Quick Setup Guide 

 

Although some settings will be populated automatically you will need to configure the following screens for 

Bellerophon HD to run smoothly 

 

Bellerophon icon -> System Options 

Staff/Users - Add Staff members and create user logins - Level 10 users bypass all button protection, a 

valid email address is needed for emails to be sent correctly 

Currency Maint – Add additional currencies 

Divisions / Customer Type – Add additional divisions and customer types 

Sales Outlet – Add your sales outlet details 

Company Information – Add your company information 

Lookup Maintenance – The lookup table allows you to add or edit the relevant tables 

Customer Credit Codes – These are the payment types 

Customer Age Brackets – These are the age brackets 

Customer Contact Titles – These are the customer titles 

Customer Country Codes – These are the country codes 

Customer Source Master/Details Info – These are the source details 

Customer Status Codes – These are the customer statuses 

Document Store File Types – These are the document extensions 

Email Server Setting – This is your email server and the email mail address that the help desk 

emails are sent from – These are required for emails to be sent 

Help Desk SLAs – These are the service level agreements 

Staff Department – These are the departments 

User Options -> My Customisation – Customise the look and feel of Bellerophon HD and the default printers 

Help Desk -> Customers – Create new customers 

Help Desk -> Help Desk -> Maintenance 

Type Maintenance – Create new custom fields and sub types 

Department Maintenance –  Add / Remove users from the department 

    Allow users to edit estimated completion dates 

    Set the Job Completion target 

    Set the Default Job Type 

    Add any Additional Email Footer Text 

    Set the Overdue Job Gauge Maximum Value 

Enable / Disable Departments – Enable or disable departments 

SLA Maintenance – Setup the service level agreements so the days left will automatically be 

calculated when logging a job 

Job Status Maintenance – Add additional helpdesk status and set others to be included or not 
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1. Summary 
 
1.1 What this screen is used for 
 
Viewing at a glance the summary of the statistics for the selected departments helpdesk 
 
Changing the summary to view  
 
1.2 Understanding the screen 
 

 
 

 
Summary to view 
These radial selections allow you to pick which summary you wish to view 

Total Helpdesk Users 
This shows the total amount of helpdesk users for the selected department 

Total Helpdesk Users Logged In 
This shows the total amount of helpdesk users currently logged in for the selected department 

Total Jobs 
This shows the job total for the selected summary 

Total Overdue Jobs 
This shows total amount of overdue jobs for the summary selected 

Total Open Jobs 
This shows the open job total for the selected summary 

Percentage of Jobs Completed On Time 
This meter shows the total amount of jobs completed on time for the selected summary 

Total Completed Jobs 
This shows the completed job total for the selected summary 

Total Cancelled Jobs 
This shows the cancelled job total for the selected summary 

Total Jobs Being Monitored 
This shows the being monitored job total for the selected summary 

Total Jobs Being Actioned 
This shows the being actioned job total for the selected summary 

 

1.3 Using the screen 

 
1.3.1 - This screen is for viewing easy to see figures for the selected summary on the selected department’s 
helpdesk. To change the summary use the radial selections at the top left of the screen, you can choose 
between All, this month, last month, this year and last year (the figures change automatically to reflect your 
selection) 
 

1.3.2 - To switch between departments you need to click the “Select Department” button to select a new one 

from the list 
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2. Jobs 
 
2.1 What this screen is used for 
 
Creating staff or customer jobs assigned to a specific person with relevant data 
 
Updating existing jobs 
 
Viewing existing job details and job history 
 
Viewing jobs in a easy to view, colour coded, list format (Red – Overdue, Yellow – Due, Green – Not Due) 
 
Exporting all jobs, selected job details or selected rows for database usage 
 
Filtering the list including hiding and showing Cancelled orders 
 
Switching Departments 
 
Adding documents and files to jobs and updating these files with newer versions 
 
2.2 Understanding the screen 
 
2.2.1 Title Bar – Edit 
 

 
 
New 
This button allows you to clear the job details below to place a new job 

Update 
Click this button to update and edit the selected job 

Export To File 
This button exports the details of the jobs in the list to a text file 

 
2.2.2 Title Bar – Filter 
 

 
 
Filter Jobs 
Click this button to filter the jobs using the selected information 

Reset Filters 
Click here to clear any filters entered and return to the default filter 

Given To 
This allows you to select which person a job was assigned to 

Status is (not) 
This allows you to select either if a status is or if a status is not the selected status 

SLA 
This allows you to select which SLA you wish to filter 

Request From Staff Member 
This allows you to select which staff member logged the job 

Request From Customer 
This allows you to select which customer logged the job 

Show Cancelled 
This tick box allows you to show or hide cancelled orders 

Date Type 
This allows you to select the date type to select 

Date From 
This allows you to select the date from 

Date To 
This allows you to select the date to 

Custom fields 
These fields are custom field’s setup for each specific helpdesk 

 
2.2.3 Title Bar – View 
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Select Department 
This button allows you to select which department you wish to view 

 
2.2.4 Title Bar – Search 
 

 
 
Find Job No 
This allows you to search for a specific job number 

Search Problem Info 
This allows you to enter text to search for in the problem info of all the jobs 

Find similar Jobs 
This button allows you to find similar jobs to the one selected 

 
2.2.5 Title Bar – When adding or updating a job 

 

 
 
Add / Save Changes 
This button allows you to add or save the changes made to an existing job 

Cancel 
This button allows you to cancel any changes made 

 
2.2.6 Help Desk Jobs tab 
 

 

 
When a Customer Request 

Customer No 
This shows the customer number 

Customer Name 
This shows the customer name 

When a Staff Request 
Request From 
This shows who requested this job 

Assigned to 
This shows who the job is assigned to 

Logged By 
This shows who logged the job initially 
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Status 
This shows the current status of the job 

SLA 
This shows the current SLA for the job 

Days Left 
This shows the number of days left until the job passes its estimated completion date 

Est Comp Date 
This shows the estimated completion date for this job 

Last Update 
This shows the date the last time the job was updated 

Staff / Customer Request 
These radial selections show which type of job this is (staff or customer) 

Reminder 
This tick box and date selector allow you to setup a reminder for the selected job 

Job No 
This shows the job number 

Job Description 
This job description is listed here 

Custom Fields 
Any custom field’s setup will be displayed here and the relevant data can be stored here 

Problem 
This shows the problem / job info and any updates that have been made to this job 

Add Problem Info 
This drop down text entry box allows you to add problem info to the selected job 

When Adding or Updating a job 
Send Assignment Email After Save 
This tick box indicates that an assignment email needs to be sent when any changes are saved / a new job is added 

Send Confirmation Email After Save 
This tick box indicates that a confirmation email needs to be sent to the staff member or customer who originally requested the job when any changes are saved / a new 
job is added 

Jobs List 
This shows a the list of jobs for the filter options selected in the title bar, this can also be filtered using the controls in the column titles 

Refresh 
This button refreshes the job list in case there have been any changes 

< 
This button shows the job details for the previous order in the list from the selected order 

> 
This button shows the job details for the next order in the list from the selected order 

Select All 
This button selects all the orders in the list above 

Export Selected Rows 
Click this button to export the highlighted rows, these can then be pasted into another application like excel 

Open Jobs 
This button shows only the open jobs (open, monitoring and actioned) 

 

2.3 Using the screen 

 

2.3.1 - To view a jobs details you can select it from the jobs list on the right (by default this doesn’t show 

Completed or Cancelled orders), you can browse through the jobs one by one using the “<” and “>” buttons to 

go back and forward by 1 job each click. To find a specific job you need to select the “Search” tab at the top 

then enter the job number into the “Find Job No” box and press return. The “Search Problem Info” box allows 

you to search all jobs for the problem information entered. The “Search Legacy No” is only used when 

searching on jobs imported from another helpdesk. You can view the “Problem Info” of a job in a new window 

by double clicking on it 

 

2.3.2 - If you wish to adjust the filter you can do this from the “Filter” tab on the task bar, click on it to view it. 

By default the only filter that is enabled is the “Status is not Complete”. The “Given To”, “Status is” and “SLA” 

can all be changed to their opposite by clicking on them (click on “SLA” changes it to “SLA is not” etc, click on it 

again to change it back). You can select the filter options using the drop down lists, once you have select all 

these click the “Filter Jobs” button to action the filter (the results are shown in the jobs list below). The “Reset 

Filters” button clears all the filters so all jobs (except cancelled) are shown in the jobs list below, to show 

cancelled orders you need to place a tick next to “Show Cancelled” then click the “Filter Jobs” button again 

 

2.3.3 - To switch between departments you need to click into the “View” tab on the taskbar then click the 

“Select Department” button to select from the list 

 



 

17 

2.3.4 - To create a new job you need to click the “New” button in the “Edit” tab on the taskbar, once you have 

done this the “Add” and “Cancel” buttons will appear on the taskbar. You need to enter all the information 

below and populate all required fields (fields that need to be entered for a job to be logged). Once you have 

populated all the necessary fields the “Est Comp Date” and the “Days Left” are calculated automatically using 

the SLAs entered. You then need to enter all the job information into the “Add Problem Info” section and click 

OK. The “Send Assignment Email After Save” and “Send Confirmation Email After Save” are both ticked 

automatically, these can be unticked if you don’t want these emails to be sent. Once you have finished 

entering the details click the “Add” button in the taskbar to save the changes, send the automatic emails, 

assign a job number and add it to the jobs list on the right. If you wish to close the job without saving it click 

the “Cancel” button on the taskbar and all changes will be discarded 

2.3.5 - If you wish to update an existing job you need to select it from the list so the details of the job are 
populated on the left then click the “Update” button in the “Edit” tab on the taskbar, once you have done this 
the “Save Changes” and “Cancel” buttons will appear on the taskbar. Once you have made any changes or 
added any additional problem information you need to click the “Save Changes” button to save any changes, 
to discard any changes click the “Cancel” button 
 
2.3.6 - There are a 2 main ways of exporting data from the help desk 

 The first is using the “Export to File” button in the “Edit” tab on the taskbar, when you click this you 
are prompted for a name and location to save the file. This exports all the jobs including the problem 
information to a text document 

 The second is the “Export Selected Rows” button underneath the jobs list, you need to highlight the 
rows in the jobs list or click the “Select All” button to highlight them all then click the button to export 
the job details to the clipboard (all apart from the problem information) you can then paste these into 
another problem such as excel for reporting purposes 

 
2.4 Job Documents tab 

 

 

 
Ref Code 
This shows the entered ref code 

Document Search All 
This button allows you to search all documents attached to any job using the entered “Ref Code” 

Document Job Search 
This button allows you to search only documents attached to this job using the entered “Ref Code” 

Add 
Click this button to add a new document to the selected job using the ‘Ref Code’ entered 

Update 
Click this button to update the selected document with a new version 

Remove Version 
Select a version from the list on the right and click this button to remove it 

Save Copy Of Document 
This allows you to save a copy of the selected document version to view and edit 

Document List 
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This shows the list of documents attached to the selected job by default (or the results from a search) 

Version List 
This shows the different versions of the selected document above 

 

2.5 Using the screen 

 

2.5.1 - The document display section automatically shows the documents attached to the selected order by 

default, you can search these documents by typing something in the “Ref Code” box then clicking the 

“Document Cust Search” button. If you wish to search all customer documents click the “Document Search All” 

button instead 

 

2.5.2 - To view the different versions of a document click on it and the versions of that document will be 

displayed below. To open and save one of these versions to your computer you need to highlight it from the 

document versions section then click the “Save Copy Of Document” button, this will then open a new window 

allowing you to select where you wish to save the document and what you want to call it 

 

2.5.3 - If you wish to add a new document to this order you need to enter the new name in the “Ref Code” 

field then click the “Add” button, this then opens a window to select a document to upload. Once you have 

uploaded this it will appear in the document display section 

 

2.5.4 - If you wish to update a document with a new version, you need to select the document from the list 

then click the “Update” button, this opens up a new window allowing you to select a later version of the 

selected document (this needs to have the same name as the original file) 

 

2.5.5 - To remove a version of a document you need to select the document, then select the version of the 

document you wish to remove then click the “Remove Version” button 
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3. Scheduler 
 
3.1 What this screen is used for 
 
Viewing jobs in a list and an outlook express style calendar view 
 
Filtering jobs 
 
Opening and viewing jobs in separate windows 
 
Opening jobs to amend them using the job viewing window 
 
Viewing the schedule in various views (week, month or timeline) 
 
Viewing a job in the calendar view using the list on the left 
 
3.2 Understanding the screen 
 

 

 
In the View tab 

Go To Date 
This date selector allows you to select a date to jump to on the calendar view 

Scheduler View 
This allows you to select the time scale shown on the calendar view  

Selected Department 
This button allows you to select a different department to view 

In the Filter tab 
Filter Jobs 
Click this button to filter the jobs using the selected information 

Reset Filters 
Click here to clear any filters entered and return to the default filter 

Given To 
This allows you to select which person a job was assigned to 

Status is (not) 
This allows you to select either if a status is or if a status is not the selected status 

SLA 
This allows you to select which SLA you wish to filter 

Request From Staff Member 
This allows you to select which staff member logged the job 

Request From Customer 
This allows you to select which customer logged the job 

Show Cancelled 
This tick box allows you to show or hide cancelled orders 

Updated Date From 
This allows you to select the update date from 

Updated Date To 
This allows you to select the update date to 

Custom fields 
These fields are custom field’s setup for each specific helpdesk 
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Jobs list 
This shows the list of the jobs for the criteria selected above 

Calendar View 
This shows the same list but in an outlook style calendar view 

 
3.2.1 Job viewer 
 

 
 
Details 
These show the details of the job being viewed 

Notes 
This shows the notes for the selected job 

Amend Job 
This button allows you to open the current job in the Jobs tab 

 
3.3 Using the screen 
 
3.3.1 - This screen shows the jobs using the filters above in a list and outlook style calendar view, if you wish to 
jump straight to a job on the calendar view you need to double click on it from the list. To go to a date you just 
need to go into the “View” tab on the task bar then select the required date from the “Go To Date” selection 
at the top 
 
3.3.2 - The scheduler view can be switched between week, month and timeline using the drop down selection 
“Scheduler View” in the “View” tab 
 
3.3.3 - To switch between departments you need to click into the “View” tab on the taskbar then click the 

“Select Department” button to select from the list 

 
3.3.4 - You can filter the jobs in the list and scheduler view using the filters in the “Filter” tab, you need to 
select the required options using the drop down lists then click the “Filter Jobs” button. The list and scheduler 
view should then show the results for the selected options. Click the “Reset Filters” button to clear any filter 
options selected and to show all not completed jobs (apart from cancelled jobs, you need to place a tick next 
to “Show Cancelled” to show these) 
 
3.3.5 - To view a jobs details you need to double click on it in the scheduler view and it will open in a new job 
viewer window. This new window will contain all the job details and the job notes. The “Amend Job” button 
opens the selected job in the “Jobs” tab and sets it so it can be amended 
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4. Management 
 
4.1 What this screen is used for 
 
Viewing performance statistics for single users or whole departments in a grid and chart view 
 
Adjusting the chart view 
 
Viewing different months, stepping through them 1 by 1 or viewing statistics between certain dates 
 
Printing off reports 
 
4.2 Understanding the screen 
 

 

 
Chart View 
Click this to select the chart view 
Show Department Totals 
Select this option to view department totals for the selected date range 

This Year 
Click this button to view this year’s stats 

Last Year 
Click this button to view last year’s stats 

Date From 
This shows the month to display stats from 

Date To 
This shows the month to display stats to 

Selected Department 
This button allows you to select a new department to view 

Print 
This allows you to print off the statistics for the users in the selected department 

Export 
This allows you to export the selected rows below to the clipboard 

View Percentages 
This radial selection allows you to view the chart in percentages 

View Totals 
This radial selection allows you to view the chart as totals 

When showing department totals 
 Month by Month stats list 

This shows the list of stats for the department by month 

When not showing department totals 
Department users list 
This shows the list of users in the selected department and their individual stats 

Chart view 
This shows the chart view for the selected user / users / department for the selected time frame 

 
4.3 Using the screen 
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4.3.1 - This screen by default shows the statistics for the users within the selected department, the highlighted 
user’s statistics are displayed in number and chart views. Select another user to view their statistics. You can 
select more than one user to group their statistics together by holding down the “Shift” or “Ctrl” keys on the 
keyboard and clicking on other users. Click “Show Department Totals” if you wish to view the department 
statistics as oppose to individual / grouped ones, click it again to return back to the individual statistics 
 
4.3.2 - The “Chart View” selection in the taskbar allows you to change the chart view. The “This Year” button 
allows you to view the statistics for this whole year up until this point and the “Last Year” button shows last 
year’s statistics. If you wish to view statistics between certain months you can enter these in the “Date From” 
and “Date To” fields. You can change the chart view from percentages to totals using the radial selections to 
the right of the statistics 
 
4.3.3 - To switch between departments you need to click the “Select Department” button then select a new 

one from the list 

 
4.3.4 - The “Print” button allows you to print off the statistics for the selected user / users / department being 
displayed to you default printer 
 
4.3.5 - The “Export Selected Rows” button allows you export the selected row within the users to the 
clipboard. They can then be pasted in another application such as Microsoft Excel 
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5. Maintenance 
 
5.1 What these screens are used for 
 
Adding and removing custom main and sub types 
 
Renaming custom main and sub types 
 
Reordering custom main types up and down the list 
 
Adding and removing selected users for the current department 
 
Setting selected users with the ability to change the estimated completion date on a job 
 
Setting up department details such as Job completion targets, default job types, additional email footer text 
and max levels on the overdue job gauge 
 
Enabling or Disabling departments 
 
Setting up multiple SLA’s for selected custom list types and selecting the default one to use 
 
5.2 Understanding the screen 
 
New Type 
This button allows you to create new custom main types 

Remove Type 
This allows you to remove a selected custom main type 

Selected Department 
This button allows you to select a new department to view 

 

5.2.1 Type Maintenance tab 
 

 
 
Custom Main Types 
This list shows the main list types setup and if they are a required field 

Move Up 
This allows you to move the selected custom type up the list, this also changes where the field appears on the Jobs tab 

Move Down 
This allows you to move the selected custom type down the list, this also changes where the field appears on the Jobs tab 

Save Changes 
This allows you to save any changes made to the custom main types 

Custom Sub Types 
This list shows the custom sub types for the selected customer main type 

Rename Selected Main Type 
This allows you to rename the selected main type  

Add Sub Type 
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This allows you to add an entered sub type 

Rename Selected Sub Type 
This allows you to rename the selected sub type  

Remove Selected Sub Type 
Click this button to remove the selected sub type 

 
5.2.2 Using the screen 
 
5.2.2.1 - To create a new main type you need to click the ‘New Type’ button in the “Edit” tab, this opens a new 
window asking you to enter name and select the format. Once you have done this click “Add” to add it to the 
list below. If you don’t wish to add one just click off the window and continue as normal 
 
5.2.2.2 - To remove a main type click the “Remove Type” button in the “Edit” tab, this opens a new window 
asking you to select which main type you wish to remove. Once you have selected one click the “Remove” 
button to remove it from the list. If you don’t wish to remove one just click off the window and continue as 
normal 
 
5.2.2.3 - To switch between departments you need to click into the “View” tab on the taskbar then click the 

“Select Department” to select from the list 

 
5.2.2.4 - The custom main types list shows the main types currently setup and also what type of field it is. 
There is a “Required Field” tick box next to each one which allows you to specify whether this field needs to be 
populated for a job to be closed. To change this either place or remove the tick / ticks then click the “Save 
Changes” button below 
 
5.2.2.5 - If you wish to change the order of the custom main types on the jobs screen you can do this by 
moving the fields up and down the list using the “Move Up” and ‘’Move Down” buttons (depending on where 
you want the fields to be displayed in the “Jobs” tab) once you have finished making changes you need to click 
the “Save Changes” button 
 
5.2.2.6 - You can create sub types for list and check custom types, if you wish to do this you need to select the 
appropriate main type from the list then enter the sub type name in the “Add Sub Type” text entry box and 
click the plus symbol to add it to the list. Repeat the process until all the sub types have been added 
 
5.2.2.7 - You can rename a main type by selecting the appropriate type from the list then enter a new name in 
the “Rename Selected Main Type” box and click the tick. You can do the same with the sub types but use the 
“Rename Selected Sub Type” text entry box instead 
 
5.2.2.8 - To remove a sub type you need to select it from the list then click the “Remove Selected Sub Type” 
button 
 
5.2.3 Department Maintenance tab 
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All Users 
This list shows all the users setup in the system 

Add 
This allows you to add the selected user to the selected department 

Remove Selected User 
This allows you to remove the selected user from the selected department 

Users In This Department 
This shows the users currently added to the selected department 

Save Changes 
This button allows you to save any changes made to ‘Users in this Department’ 

Job Completion Target 
This shows the job completion target for the selected department 

Default Job Type 
This allows you to select which job type is default for the selected department 

Additional Email Footer Text 
This section allows you to enter any additional email footer text for the selected department 

Overdue Job Gauge Maximum Value 
This allows you to select the overdue job gauge maximum value which is displayed in the “Summary” tab for this department 

Only when changes have been made 
Apply 
This allows you to save any changes made to the “Job Completion Target”, “Default Job Type”, “Additional Email Footer Text” and “Overdue Job Gauge Maximum Value” 

 
5.2.4 Using the screen 
 

5.2.4.1 - The “All Users” list shows all the active users in the system and the “Users In This Department” list 
shows the users which are currently in the selected department. If you wish to add someone to the 
department you are currently in select them from the “All Users” list then click the “Add” button (the user will 
then show in the department list). To remove a user from the selected department select them from the 
“Users In This Department” list then click the “Remove Selected User” button 
 
5.2.4.2 - The tick boxes next to each user in the “User in this Department” list allows you to specify if the user 
can edit the estimated completion date when editing a job, once you have made any changes click the “Save 
Changes” button 
 
5.2.4.3 - In the section below the “All Users” list you to alter the “Job Completion Target”, “Default Job Type”, 
“Additional Email Footer Text” and the “Overdue Job Gauge Maximum Value”, once you have made the 
changes you need to click the “Apply” button to save them 
 

5.2.5 Enable / Disable Departments tab 
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Department List 
This shows the list of departments and it shows if the department is enabled 

Refresh department Lists 
This button allows you to refresh the department list 

 
5.2.6 Using the screen 
 
5.2.6.1 - This tab allows you to enable and disable departments. The list shows all the departments currently 
setup in the system, the enabled departments have a tick next to them and are highlighted in green. If you 
wish to enable a department you need to place a tick next to it in the “Department Enabled” column. To 
disable a department remove the tick next to it (it will then not be highlighted in green). You will always need 
to have at least 1 department enabled. Click the “Save Changes” button to save any changes made 
 
5.2.6.2 - You can use the “Refresh department Lists” button in case you want to refresh the list to see if there 
have been any changes made to the departments 
 
5.2.7 SLA Maintenance tab 
 

 
 
Link Priority with list 
This shows the list of custom list fields  

Item Sub Types 
This shows the sub types for the selected custom list 

Default working days by priority 
This allows you to enter the SLA’s for the selected sub type 

Save changes 
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This button allows you to save the changes to the SLA’s for a sub type 

Discard changes 
Click this button to discard any changes made 

Current Default 
This shows the current default SLA’s to use 

Set Default 
This button allows you to set the selected custom list field as the default SLA’s to use 

 
5.2.8 Using the screen 
 
5.2.8.1 - This tab shows the list of custom list fields setup in the “Type Maintenance” tab (check and text 
custom fields are not shown). The “Item Sub Type” list shows the sub types setup within the selected main 
type. You can view the SLA’s (Service Level Agreements) setup for a selected sub type within a selected main 
type by selecting it from the list 
 
5.2.8.2 - If there are no SLA’s setup select the appropriate main and sub type then enter the figures into the 
“Default working days by priority” fields and click the “Save Changes” button. Click the “Discard changes” 
button to discard any changes made to the SLA’s 
 
5.2.8.3 - If there are already SLA’s setup you can alter these by selecting the appropriate main and sub type 
then change the “Default working days by priority” figures as necessary and click the “Save Changes” button. 
Click the “Discard changes” button to discard any changes made to the SLA’s 
 
5.2.8.4 - The currently selected default SLA’s to use are shown under the Save and Discard buttons. You can 
change this by selecting another main list type and clicking the “Set Default” button on the right. This will then 
use the new SLA’s to automatically calculate the number of days left when creating a new job 
 

5.2.9 Job Status Maintenance tab 
 

 
 
Job status list 
This shows the list of job status and shows if they are included or not 

Add New Status 
This button allows you to add the new status 

Remove Status 
This button allows you to remove the selected status 

Save Status Changes 
This button allows you to save any changes made 

 

5.2.10 Using the screen 
 
5.2.10.1 – To add a new status click the ‘Add New Status’ button to add a new blank line into the list above. 

Enter the name in this new line then click the ‘Save Status Changes’ button to save the new status. To remove 

a status select it from the list then click the ‘Remove Status’ button 
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5.2.10.2 – The status in the list have a tick box next to each one which allows you to specify if these status are 

included in the job grid in the ‘Jobs’ tab. If you change any of these ticks you will need to click the ‘Save Status 

Changes’ button to save the changes 
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6. Customers -> Customer Details 

 

6.1 What this screen is used for 

 

Searching and viewing existing customer details including invoice, head office and any delivery addresses 

 

Adding new customer details 

 

Adding new addresses to an existing customer and changing default addresses 

 

6.2 Understanding the screen 

 

 
 
Customer Main Details 
This section contains the main customer details 

Customer 
This shows the customer name 

Account No 
This shows the account number for the customer 

Status 
Shows the current status of the customer 

Customer Type 
Shows which type of customer this is 

Sales Outlet 
The customer sales outlet 

Sales Manager 
The sales manager for this customer 

Linked to Customer 
This shows if this customer is linked to another customer 

Customer No 
Shows the customer number 

Country 
Shows the country code 

Credit Code 
Any credit code is listed here 

Source Master 
This shows the master source 

Source Detail 
This shows the source detail 

Age Bracket 
Shows which age bracket the customer falls into 

Budget 
Shows the budget for the customer 
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Credit Limit 
The credit limit is listed here 

UnInvoiced 
Shows the total for anything that wasn’t invoiced 

Currency 
Shows the default currency for this customer 

Exclude From Mailshots 
This tickbox indicates if this customer should be excluded from mailshots or not 

Custom Fields 
Any fields below are the custom field’s setup in the Custom Fields tab 

Customer Address and Contact Details 
This section contains the address details for the selected customer 

Address Type 
This shows the list of addresses setup for this customer, the default address is highlighted in yellow 

Title 
This shows the customer’s title 

Forename 
The forename for the customer at the address 

Surname 
The surname for the customer at the address 

Tel No 
The telephone number 

Fax No 
The fax number 

Mobile No 
The mobile number if applicable 

Email 
The contact email address 

Add New Contact 
This button allows you to add the contact entered above as a new contact 

Property 
This shows the property name 

Street 
Shows the first line of the address 

Locality 
The location of the address 

Town 
The town address 

County 
The county 

Postcode 
The address postcode 

Website 
The website address if applicable 

New Address Options 
When creating a new address for the customer you can select which address you want it to be by using the radial selections listed here 

Set As Default on Add 
This tick box allows you to let the system know that the next address you add will be the default address 

Add Address as a New ‘Invoice’ Address 
This button allows you to add the new address as the new invoice address 

Customer information and overall buttons 

Added By 
This shows who added this customer and the date and time they did this 

Last Updated By 
This shows who the last person was to update this customer and the date and time they did this 

Add as New Customer 
This button allows you to add the above information as a new customer 

Reset Form 
This button allows you to clear the above information to start off again from scratch 

Update Current Customer 
This button allows you to save any change made to the customer details above 

Move Previous 
This button moves you back to the previous customer in the system 

Move Next 
This button moves you forward to the previous customer in the system 

Customers 
This shows the total amount of customers in the system 

Search Section 
This section allows you to search the existing customers and assign tasks to them 

Find 
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This free text box allows you to enter information to search on 

Use Fuzzy Search 
This tick box allows you to enable fuzzy searching when searching customers 

Search Results 
This shows the search results for the entered search criteria 

 

6.3 Using the screen 

 

6.3.1 - This screen allows you to view the details of a customer plus all the addresses linked to this customer. 

You can view each address individually by selecting it from the “Address Type” list. Default addresses are 

highlighted in yellow, you can alter these by selecting another one from the list and clicking the “Set this 

Address as Default”. Safe Addresses are in bold, can you set any address to safe or unsafe by selecting the 

address then clicking the “Set / Unset this Address as a Safe Address” button 

 

6.3.2 - To search for a new customer you use the search box on the right, type in what you wish to search for in 

the “Find” box then click the “...” button or press the return key. The search results will be displayed below, 

click on one to view the customer details. If your search does not get any results you can turn on “Fuzzy 

Search” using the tick box to enable inexact searching (This is helpful when you’re not exactly sure what the 

details are for the customer you’re searching for). You can also flick through the customer records by using the 

“Move Previous” and “Move Next” buttons 

 

6.3.3 - If you wish to save any changes made to an existing customer you need to click the “Update Current 

Customer” button after making the changes. To create a new customer you need to either alter the details of 

an existing customer or click the “Reset Form” button to start from scratch, once you have finished making 

changes click the “Add as New Customer” button to create the customer record (note that the contact 

information entered at the bottom will be copied to all 5 of the address types by default when the new 

customer is created) 
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7. Customers -> Customer Notes 

 

7.1 What this screen is used for 

 

Viewing all the task and customer notes for the selected customer, you can limit the notes being displayed 

using the radial selections at the bottom 

 

Adding new notes to the customer record 

 

Enabling a customer alert and entering that alert 

 

7.2 Understanding the screen 

 

 
 

Notes 
This section shows the notes selected 

Add Notes / Alert 
This button adds the notes entered on the left 

All Notes 
This allows you to select all notes to be viewed 

Task Notes Only 
This allows you to show task notes only 

Generic Notes Only 
This allows you to show generic notes only 

Enable Alert 
This tick box allows you set the entered alert as a pop up 

 

7.3 Using the screen 
 

7.3.1 - You can view the notes for this customer in this tab, you can alter which notes are being viewed by 

using the radial selections (all notes, task notes or general notes) 

 

7.3.2 - To add new notes you need to enter the text into the free text box then click the “Add Notes / Alert” 

button, this will then add the notes to the customer notes above 

 

7.3.3 - If you wish to enable a pop-up alert for this customer when you open the record you need to place a 

tick in the “Enable Alert” tick box then type the alert in the new free text box to the right that you wish to 

appear 
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8. Customers -> Customer Documents 

 

8.1 What this screen is used for 

 

Adding, removing, updating and viewing documents attached to this customer. You can also download a copy 

of any documents saved in the system 

 

Adding new versions of existing files 

 

8.2 Understanding the screen 

 

 
 

Ref Code 
This is where you type what you want to search for 

Document Search All 
This button allows you to search all the documents (not just for the customer) for the code entered 

Document Cust Search 
This button allows you to search the selected customer documents using the code entered 

Add 
This allows you to add a new document to this customer  

Update 
This button allows you to update the document selected 

Remove Version 
This allows you to remove the selected version 

Save Copy Of Document 
This allows you to save a copy of the selected document onto the computer 

Document display section 
This section shows by default the documents attached to the selected customer, it also shows search results 

Document version section 
This section shows the available versions of the document selected 

 

8.3 Using the screen 

 

8.3.1 - The document display section automatically shows the documents attached to the selected customer 

by default, you can search these documents by typing something in the “Ref Code” box then clicking the 

“Document Cust Search” button. If you wish to search all customer documents click the “Document Search All” 

button instead 

 

8.3.2 - To view the different versions of a document select it and the versions of that document will be 

displayed below. To open and save one of these versions to your computer you need to highlight it from the 
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document version section then click the ‘Save Copy Of Document’ button, this will then open a new window 

allowing you to select where you wish to save the document and what you want to call it 

 

8.3.3 - If you wish to add a new document to this customer you need to enter the new name in the “Ref Code” 

field then click the “Add” button, this then opens a window to select a document to upload. Once you have 

uploaded this it will appear in the document display section 

 

8.3.4 - If you wish to update a document with a new version, you need to select the document from the list 

then click the “Update” button, this opens up a new window allowing you to select a later version of the 

selected document (this needs to have the same name as the original file) 

 

8.3.5 - To remove a version of a document you need to select the document, select the version of the 

document you wish to remove then click the “Remove Version” button 
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9. Customers -> Custom Fields 

 

9.1 What this screen is used for 

 

Creating custom fields and assigning them to certain customer types 

 

Updating and remove existing custom fields 

 

9.2 Understanding the screen 

 

 
 

New Field Type 
This section allows you to select what type of custom field to add 

New Field Type selection 
This section allows you to select what type of custom field to add (Textbox, Tickbox, Multiple choice or date / time) 

Label Text with Field Type 
This allows you to type the name of the new custom field 

Preview 
This section contains a preview of the custom field selected above 

> 
Moves onto the field setup section 

< 
Moves back to the field type section 

Field setup 
This section allows you to setup the custom field 

Preview 
The first box shows the preview again 

Add Choices to the Drop Down (only when creating a multiple choice custom field) 
This allows you to enter choices to add to the list 

Assign Customer Types to Field 
This pull down list allows you to select which customer types to add 

> 
Adds the selected customer type to the list 

< 
Removes the selected customer type from the list 

>> 
Adds all the customer types from the list 

<< 
Removes all the customer types from the list 

Save New Field Type 
Click this button to save the field type being created 

Cancel 
Cancel any changes made to the new custom field 

Existing Custom Fields 
This section shows the existing custom fields and the buttons to edit and remove them 
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Existing fields list 
This list shows all the custom field currently setup 

Edit Existing Field Type 
This allows you to edit the selected custom field 

Delete Existing Field Type 
This button allows you to remove the selected field type 

Refresh List 
This button allows you to refresh the list in case there have been any changes 

 

9.3 Using the screen 

 

9.3.1 - To create a new custom field you first need to select a new field type from the selection box at the top 

left (text, tick, multiple choice or date / time) then enter a name for your custom field in the “Label Text with 

Field Type” box. The preview section below shows a preview of your selected custom field, to continue click 

the “>” button and the “Field Setup” section becomes active, to return back to the “New Field Type” section 

click the “<” button. The Field Section allows you to see a preview of the custom field again and an option to 

add customer types for this field, select a customer type from the drop down list then click the “>” button to 

add it. To remove a customer type select it and click the “<” button. The “<<” button removes all the customer 

types to start from blank again. With the multiple choice custom field you will all have another selection where 

you can add the selections that will appear in the drop down list once complete (the button configuration is 

the same as the customer types one). To save the entered custom field as a new field click the “Save New Field 

Type” button and it will appear in the list below. Click “Cancel” if you wish to cancel any changes 

 

9.3.2 - To edit an existing field you need to select it from the list then click the “Edit New Field Type” button, 

the field details will then be displayed in the “Field Setup” tab. Once you have made all the necessary 

alterations click the “Update New Field Type” button to save the changes or cancel if you don’t wish to save 

any changes made 

 

9.3.3 - To delete a custom field, select it from the list and click on the “Delete New Field Type” button (note: 

you will not be able to remove a custom field with data attached to it) 

 

9.3.4 - The refresh list button refreshes the list in case there have been any changes 
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10. Staff/Users 

 

10.1 What this screen is used for 

 

Viewing, creating and editing staff details 

 

Adding and amending user details for staff members 

 

Setting staff members with the ability to sell to selected outlets 

 

Enabling and disabling users 

 

10.2 Understanding the screen 
 

 
 

Staff Members / Users Total 
This shows the total number of staff members and users in the list 

Staff Members list 
This shows the list of staff members and users (disabled staff members show in red) 

Hide Enabled Users 
This tick box allows you to hide enabled users 

Hide Disabled Users 
This tick box allows you to hide disable users 

Hide Staff Members with no User Name 
This tick box allows you to hide staff members with no user name 

Tick All 
This allows you to tick all the staff members in the list 

UnTick All 
This allows you to untick all the staff members in the list 

Invert Ticks 
This allows you to invert the ticks selected above 

Refresh List 
This allows you to refresh the list in case there has been any changes 

Forename 
This shows the first name for the selected staff member 

Surname 
This shows the surname for the selected staff member 

Job Title 
This shows the job title for the selected staff member 

Email 
This shows the email address for the selected staff member 

Division 
This shows the selected division for the selected staff member 

Department 
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This shows the selected department for the selected staff member 

Image 
This shows the image of the staff member if one has been uploaded 

Show Staff Member in List in certain Screens 
This tick box allows you to show staff members in certain screens 

Sales Manager 
This tick box allows you to enable the selected staff members as a sales manager 

Customer Services User 
This tick box allows you to enable the selected staff members as a customer services user 

Can Sell 
This tick box allows the selected staff members to sell 

Only show for ‘Can Sell’ enabled users 

Sales Outlet 
This allows you to select a sales outlet from the drop down list 

Add 
This button allows you to add the selected outlet to the outlet list below 

Outlets List 
This shows the list of outlets which have been added 

Save as Staff Member 
This button allows you to save the entered details as a new staff member 

Update 
This allows you to save any changes made to an existing user 

Clear All Details 
This button allows you to clear all the detail above to start entering a new staff member from scratch 

User Name 
This shows the username for the selected staff member 

Customer Type 
This shows the selected customer type for the selected staff member 

Password 
This stored the password for the selected user (show as asterisk for security) 

Access Level 
This shows the access level for the user 

User Enabled 
This tick box allows you to enable or disable the user 

Update User 
This button allows you to save any changes made to the user 

Create PDA Login 
This button allows you to create PDA login details for this user 

Clear User Alerts 
This button allows you to clear all the user alerts for this user 

 

10.3 Using the screen 
 

10.3.1 - The list on the left shows the list of staff members (staff members which are not shown in certain 

screens are highlighted in red). You can limit the staff members being shown using the tick boxes below. To 

view the details of a staff member select them from the list and the details will be displayed on the right 

 

10.3.2 - To create a new staff member you can either use an existing staff members details and click ‘Save as 

New Staff Member’ or click the ‘Clear All Details’ button to start entering a new staff member from scratch 

 

10.3.3 - To create user details for a staff member right click on them in the list then select ‘Create User Name’. 

You will then get the user options on the left (already populated with a suggested username), you then need 

to enter the username and password and then select the customer type and access level using the drop down 

selections 

 

10.3.4 - To edit existing staff / user details select the staff member from the list on the left and the details are 

displayed on the right. Once you have made any changes click the ‘Update’ button to save them. If you tick 

‘Can Sell’ you will then have more options below to specify which outlets the selected staff member can sell 

for 

 

10.3.5 - You can disable a staff member by selecting them from the list and removing the tick from ‘Show Staff 

Member in Lists in certain screens’, you can also disable a number of staff members at the same time by 
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placing ticks next to them then right clicking on the staff members list and clicking the ‘Disable Ticked Users’ 

option. You can enable these again by placing the tick back in the ‘Show Staff Member in Lists in certain 

screens’ or ticking them in the list then right clicking and selecting ‘Enable Ticked Users’ 

 

10.3.6 - If users are having issues trying to log into the system you can kick them out by ticking them in the list 

then right clicking and selecting ‘Kick Ticked Users’ 

  



 

40 

11. User / Group Security 

 

11.1 What this screen is used for 

 

Creating / Renaming and Removing security groups 

 

Adding / Removing selected users from security groups and setting any exclusions 

 

Setting up access to buttons for selected security groups 

 

Maintaining Buttons within Forms within Modules and viewing which buttons a user can access 

 

11.2 Understanding the screens 

 

11.2.1 Understanding View User Group Security and Configure Exclusions 

 

 
 

Current Users list 
This shows the list of the users currently setup in the system 

Groups that the user is assigned to list 
This shows the list of groups that the selected user is assigned to 

Button access list 
This shows the buttons the selected group can access 

Exclude selected for User 
This button allows you to exclude the selected button from the selected user in the selected group 

Exclusions list 
This shows the list of buttons from which the selected user is excluded from in the selected group 

Remove Selected Exclusions for User 
This button allows you to remove the selected exclusions for the selected user in the selected group 

 

11.2.2 Using View User Group Security and Configure Exclusions 

 

11.2.2.1 - To view and security groups and exclusions for a selected user select them from the list on the left 

and you will then be shown 3 lists 

 The groups list shows which groups the selected user has been assigned to 

 The buttons list shows the buttons which the selected group can access 

 The exclusions list shows the buttons which the selected user is excluded from in the selected group 
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11.2.2.2 - If you wish to add extra buttons into the exclusions list select the user, then the group and then the 

button you wish to exclude. Click the “Exclude Selected for User” button, this will then show the new exclusion 

in the list below. Repeat to add more buttons to the exclusions list 

 

11.2.2.3 - To remove an exclusion select it from the list and then click the “Remove Selected Exclusions for 

User”, it will then be removed from the list 

 

11.2.3 Understanding Group and User Assignment 

 

 
 

User Security Groups list 
This shows the list of security groups currently setup in the system 

Group Name 
This shows the security group name selected 

Add New Group 
This allows you to add a new security group using the group name entered 

Rename Group 
This allows you to rename the selected group using the group name entered 

Remove Group 
This allows you to remove the selected group 

Users Assigned to Group list 
This shows the list of users assigned to the selected group 

Username selector 
This allows you to use a drop down list to select a username 

Add User to Group 
This button allows you to add the selected user to the selected group 

Remove User from Group 
This button allows you to remove the selected user from the selected group 

 

11.2.4 Using Group and User Assignment 

 

11.2.4.1 - You can view which users have been assigned to a security group by selecting the group from the 

“User Security Groups” list on the left, the users assigned will now be shown in the list on the right hand side 

 

11.2.4.2 - To add new users to a security group firstly select the group from the groups list. Once this is 

selected select the user you wish to add using the drop down list in the username selector then click the “Add 

User to Group” button. The new name will now appear in the users assigned list above 

 

11.2.4.3 - To remove a user from a group select the group then the name you wish to remove and click the 

“Remove User from Group” button 
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11.2.4.4 - Once you have selected a group its name will be displayed in the Group Name display box. If you 

wish to rename the group retype what is there then click the “Rename Group” button to save the changes 

 

11.2.4.5 - If you wish to remove a group select the group from the list then click the “Remove Group” button, it 

will then be removed completely 

 

11.2.4.6 - To create a new group type a name into the Group Name display box then click the “Add New 

Group” button, the new group will then be added to the list 

 

11.2.5 Understanding Group Button Access 

 

 
 

User Security Groups list 
This shows the list of security groups currently setup in the system 

Buttons list per group 
This shows the list of buttons the selected group can access 

Remove Access to Selected Buttons from Group 
This button allows you to remove access to selected button from the selected group 

Current Buttons setup within the System list 
This shows the list of buttons currently setup in the system 

Add Access to Selected Buttons for Above Group 
This button allows you to add access for the selected buttons to the selected group 

 

11.2.6 Using Group Button Access 

 

11.2.6.1 - This screen shows the security groups and the buttons which each of them can access, to view which 

buttons a certain security group can view select the group from the “User Security Groups” list on the left, the 

buttons will be displayed on the right 

 

11.2.6.2 - If you wish to remove buttons from a security group, select the group and highlight the button / 

buttons you wish to remove from the “The Group can Access These Buttons” list then click the “Remove 

Access to Selected Buttons from Group” button 

 

11.2.6.3 - If you wish to add extra buttons to a group, select the group then highlight the button / buttons you 

wish to add in the “Current Buttons setup within the System” list and click the “Add Access to Selected Buttons 

for Above Group”. These buttons will then appear in the “The Group can Access These Buttons” list above 

 

11.2.7 Understanding System Button Maintenance 
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Current Modules list 
This shows the list of modules currently setup in the system 

Module name 
This shows the module name selected 

Add New Module 
This button allows you to add the entered module as a new module 

Remove Module 
This allows you to remove the selected module 

Forms within Module list 
This shows you the list of forms within the selected module 

Screen Name 
This shows the screen name selected 

Add New Screen 
This button allows you to add the entered screen name as a new screen 

Form Name 
This shows the form name selected 

Remove Screen 
This allows you to remove the selected screen 

Buttons within Form list 
This shows the list of buttons within the selected form 

Button Text 
This shows the text for the selected button 

Add New Button 
This allows you to add a new button using the details entered 

Button Name 
This shows the button name selected 

Remove Selected 
This button allows you to remove the selected button 

Buttons User Can Access list 
This shows the list of buttons the selected user can access 

Remove Selected Buttons From User 
This button allows you to remove the selected buttons from the user 

Add Above Selected Buttons to User 
This allows you to add the buttons selected in the list above to the access list for the selected user 

Show Button Access for User 
This allows you to select a user to view which buttons they have access to, use the drop down list 

... 
This allows you to action the search once you have selected a user 

 

11.2.8 Using System Button Maintenance 

 

11.2.8.1 - This screen allows you to view and maintain the buttons and forms within a module, to view the 

forms within a module select the module from the “Current Modules” list. The forms within that module will 

be displayed to the right in the “Forms within Module” list. The buttons within the highlighted form will be 
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displayed to the right of that in the “Buttons within Form” list. To view the buttons within a different form just 

select a different form from the list 

 

11.2.8.2 - You can add a new module to the “Current Modules” list by entering a new module name into the 

text box underneath the list then clicking the “Add New Module” button (this will then be added into the list 

above). To remove a module select it from the list then click the “Remove Module” button 

 

11.2.8.3 - You can add a new form to the “Forms within a Module” list by entering a new form name into the 

“Screen Name” box then adding a form name into the “Form Name” box underneath the list. You then click 

the “Add New Screen” button (this will add the new form into the list above). To remove a form select it from 

the list then click the “Remove Screen” button 

 

11.2.8.4 - You can add a new button to the “Buttons within Form” list by entering new information into the 

“Button Text” and “Button Name” underneath the list then clicking the “Add New Button” button (this will 

then add the new button into the list above). To remove a button select it from the list then click the “Remove 

Selected” button 

 

11.2.8.5 - If you wish to view the buttons which a selected user can access select the name in the “Show 

Button Access for User” box using the drop down list then click the “...” button. The buttons which that user 

can access will then be shown in the list to the right. To remove the access from one of these buttons select it 

from the list then click the “Remove Selected Buttons From User” button 
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12. Currency Maint 

 

12.1 What this screen is used for 

 

Adding, updating and removing currencies 

 

Setting a selecting currency as default 

 

12.2 Understanding the screen 

 

 
 

Current Currencies list 
This shows the list of currencies currently setup in the system, the home currency is highlighted in yellow 

Set Selected as Home Currency 
This allows you to set the selected currency as the home currency 

Remove Selected Currency 
This allows you to remove the selected currency 

Refresh List 
This allows you to refresh the list in case there have been any changes 

Currency Name 
This shows the currency name 

Currency Abbreviation 
This shows the abbreviation for the selected currency 

Currency Symbol 
This shows the symbol for the selected currency 

Exchange Rate 
This shows the exchange rate for the selected currency 

Add New 
This allows you to add the entered details as a new currency 

Update 
This allows you to save any changes made to an existing currency 

Clear Details 
This allows you to clear the currency details to start entering a new one from scratch 

 

12.3 Using the screen 

 

12.3.1 - You can view the list of currencies setup in the “Current Currencies” list. This includes information such 

as the name, abbreviation, symbol and exchange rate. The default home currency is highlighted in yellow 

 

12.3.2 - To alter a currencies details, select it from the list to show the currency details to the right. You can 

then alter the details and click “Update” to save the changes 

 



 

46 

12.3.3 - To add a new currency you can either use an existing currency as a template or start from scratch by 

clicking the “Clear Details” button first. Once you have finished entering all the currency details click the “Add 

New” button to create a new currency and add it to the list 

 

12.3.4 - To remove a currency select it from the “Current Currencies” list then click the “Remove Selected 

Currency” button underneath 

 

12.3.5 - To set a currency as the default home currency you need to select it from the “Current Currencies” list 

then click the “Set Selected as Home Currency”. This will highlight that selected currency in yellow 
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13. Divisions / Customer Types 

 

13.1 What this screen is used for 

 

Adding, renaming and removing divisions 

 

Adding, renaming and removing customer types 

 

Setting discount levels per division and customer type 

 

13.2 Understanding the screen 

 

 
 

Divisions section 

Current Divisions list 
This shows the list of division’s setup in the system 

Remove Selected Division 
This allows you to remove the selected division 

Refresh List 
This allows you to refresh the list in case there have been any changes 

Name 
This shows the name of the selected division 

Code 
This shows the code for the selected division 

Discount % 
This shows the discount for the selected division, you can change this using the up and down arrows 

Add New 
This allows you to add details entered as a new division 

Update 
This allows you to save any changes made to an existing division 

Clear Details 
This allows you to clear the details to start entering a new division from scratch 

Customer Types section 

Current Customer Types list 
This shows the list of customer type’s setup in the system 

Remove Selected Customer Type 
This allows you to remove the selected customer type 

Refresh List 
This allows you to refresh the list in case there have been any changes 

Name 
This shows the name of the selected customer type 

Code 
This shows the code for the selected customer type 

Division 
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This shows the division for the selected customer type, you can select a new one using the drop down list 

Discount % 
This shows the discount for the selected customer type, you can change this using the up and down arrows 

Add new 
This allows you to add details entered as a new customer type  

Update 
This allows you to save any changes made to an existing customer type 

Clear Details 
This allows you to clear the details to start entering a new customer type from scratch 

 

13.3 Using the screen 

 

13.3.1 - To view a divisions settings select it from the “Current Divisions” list and the details will be displayed 

on the right. You can alter the settings by entering / selecting new options then use the “Update” button to 

save the changes 

 

13.3.2 - To add a new division you can either use an existing division as a template or start from scratch by 

clicking the “Clear Details” button first. Once you have finished entering all the division details click the “Add 

New” button to create a new division and add it to the list 

 

13.3.3 - To remove a division select it from the “Current Divisions” list then click the “Remove Selected 

Division” button 

 

13.3.4 - To view a customer type’s settings select it from the “Current Customer Types” list and the details will 

be displayed on the right. You can alter the settings by entering / selecting new options then use the “Update” 

button to save the changes 

 

13.3.5 - To add a new customer type you can either use an existing customer type as a template or start from 

scratch by clicking the “Clear Details” button first. Once you have finished entering all the customer type 

details click the “Add New” button to create a new customer type and add it to the list 

 

13.3.6 - To remove a customer type select it from the “Current Customer Types” list then click the “Remove 

Selected Customer Type” button 
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14. Sales Outlets 

 

14.1 What this screen is used for 

 

Adding new and updating existing Sales Outlets 

 

Setting discount levels per outlet 

 

14.2 Understanding the screen 

 

 
 

Current Sales Outlets list 
This shows the list of sales outlets currently setup in the system 

Refresh List 
This allows you to refresh the list in case there have been any changes 

Outlet Main Details 

Outlet No 
This shows the outlet number 

Account No 
This shows the account number 

Outlet Name 
This shows the name of the outlet 

Credit Limit 
This shows the credit limit 

Status 
This shows the sales outlets current status, you can select a new one using the drop down list 

Type 
This shows the customer type, you can select a new one using the drop down list 

Division 
This shows the division, you can select a new one using the drop down list 

Standard Discount % 
This shows the standard discount, you can change this using the up and down arrows 

Display Discount % 
This shows the display discount, you can change this using the up and down arrows 

Markup Factor 
This shows the markup factor, you can change this using the up and down arrows 

Outlet Address Details 

Property 
This shows the property name 

Street 
This shows the street name 

Locality 
This shows the locality 

Town 
This shows the town 
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County 
This shows the county 

Post Code 
This shows the post code 

Tel No 
This shows the phone number 

Fax No 
This shows the fax number 

Mobile No 
This shows the mobile number 

Email 
This shows the email address 

Website 
This shows the website address 

Contact Title 
This shows the contact title 

Contact Forename 
This shows the contact forename 

Contact Surname 
This shows the contact surname 

Add New 
This button allows you to add the entered details as a new outlet 

Update 
This button allows you to save any changes made to an existing outlet 

Clear Details 
This allows you to clear the details to start entering a new sales outlet from scratch 

 

14.3 Using the screen 

 

14.3.1 - You can view a sales outlet’s details by selecting it from the list. All the outlet main and address details 

will then be displayed to the right. You can alter the settings by entering / selecting new options then use the 

“Update” button to save the changes 

 

14.3.2 - To add a new sales outlet you can either use an existing sales outlet as a template or start from scratch 

by clicking the “Clear Details” button first. Once you have finished entering all the sales outlet details click the 

“Add New” button to create a new sales outlet and add it to the list 
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15. Company Information 

 

15.1 What this screen is used for 

 

Adding and updating company information 

 

Adding, amending and removing a company logo 

 

15.2 Understanding the screen 

 

 
 

Company Name 
This shows the company name 

Company Address 
This shows the company address 

Company Post Code 
This shows the company post code 

Company Telephone Number 
This shows the company phone number 

Company Fax Number 
This shows the company fax number 

Company Logo 
This shows the company logo if one has been uploaded 

Amend Logo 
This button allows you to amend the company logo 

Clear Logo 
This button allows you to clear the logo 

Company Email Address 
This shows the company email address 

Company Website 
This shows the company website address 

Company Number 
This shows the company number 

Company VAT Code 
This shows the company VAT Code 

Update Info 
This button allows you to save any changes made to the company information 

 

15.3 Using the screen 

 

15.3.1 - This screen shows the entered company information, if you wish to alter this you need to click the 

“Update Info” button afterwards to save any changes made 
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15.3.2 - If you wish to change the company logo, click the “Amend Logo” button then select a new image file to 

import (bmp, gif, jpg, wmf, emf, tif file formats supported). To remove the company logo click the “Clear Logo” 

button 
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16. Lookup Maintenance 

 

16.1 What this screen is used for 

 

Adding and updating entries on existing lookup tables 

 

16.2 Understanding the screen 

 

 
 

Current LookUp Tables list 
This shows the list of lookup tables currently added to the system 

Table Details list 
This shows the table details for the selected lookup table 

Add a New Row to Grid for Editing 
This button allows you to add an entry into the selected lookup table 

Save the New Rows 
This button allows you to save any changes made to the selected lookup table 

 

16.3 Using the screen 

 

16.3.1 - To view the contents of a lookup table select it from the “Current LookUp Tables” list on the left and 

the table details will be displayed to the right 

 

16.3.2 - To add a new row to a selected table click the “Add a New Row to Grid for Editing” button. Once the 

row has been added you can enter the details in the new row in the list above. Once you have finished you 

need to click the “Save the New Rows” to save any changes made 
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17. System Keys 

 

17.1 What this screen is used for 

 

Reloading and activating system keys 

 

17.2 Understanding the screen 

 

 
 

Company Name 
This shows the company name key 

Update Key 
This button allows you to update the company name key 

System Version 
This shows the current system version key 

Update Key 
This button allows you to update the system version key 

No of Users 
This shows the number of users limit 

Registration link 
This link takes you to the product registration screen on the Argonaut website 

Re-Load All Keys 
This button allows you to reload all the keys 

Activate 
This button allows you to activate the system once the 2 valid keys have been entered 

System Keys list 
This shows the list of system keys currently activated 

 

17.3 Using the screen 

 

17.3.1 - This shows the system keys, you can update these by typing in new ones and clicking the “Update Key” 

buttons (warning: invalid keys may cause the system to stop working). If you accidently enter invalid 

information into one of the keys you can click the “Re-Load All Keys” button to put the old keys back in again 
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18. Report Creation Tool 

 

18.1 What this screen is used for 

 

Creating, viewing and editing reports and report components 

 

18.2 Understanding the screen 

 

 
 

Main window 
This has all the main controls in including the standard menus, tool box, field list and the property grid 

Designer 
This section allows you to create the report and edit the formula, parameters, fields etc 

Designer tab 
This allows you to edit the main report in a designer view 

Preview 
This allows you to preview the current report 

HTML View 
This allows you to preview the current report in a HTML format 

Report Edit tab 
This allows you to edit the report details and contents 

Selection 
This allows you to add, edit and remove selections 

Running Totals 
This allows you to add, edit and remove running total fields 

Formulae 
This allows you to add, edit, remove and test formulae 

Parameters 
This allows you to setup and edit the parameter fields and static values 

Parameter Fields 
This allows you to select parameters to add to the report 

Static Values 
This allows you to add, rename and remove static values for the report 

Relationship Edit tab 
This allows you to setup the relationships between the various fields and tables and manage the links 

Report Fields 
This allows you to setup the relationships between the various fields and tables 

Link Maintenance 
This allows you to manage, add and remove selected links 

Report Maintenance tab 
This allows you to rename and remove previously saved reports 

 

18.3 Using the screen 

 

Use this as a normal reporting package to create a report 
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19. My Customisation 

 

19.1 What this screen is used for 

 

Customising the colours, scheme and background picture 

 

Setting and adjusting the default printers 

 

19.2 Understanding the screen 

 

 
 

Change colour scheme 
This allows you to change background colour 

Use Default 
This allows you to set the colour scheme back to the default colour 

Set New Background 
This allows you to change the main background picture 

Use Default 
This allows you to set the background picture back to the default picture 

Change Main System and New Screens Colour Scheme 
This drop down allows you to change the main colour scheme 

Use Default 
This allows you to set the Main System and New Screens Colour Scheme back to the default 

Default Label Printer 
This shows the current default label printer 

Default Document Printer 
This shows the current default document printer 

Clear Defaults 
This allows you to clear the default printers 

Change Default Printer(s) 
This button allows you to alter the default printers 

Only shown when changing the default printers 

Printer list 
This shows the list of printers currently installed in windows 

Set printer selector 
This allows you to select which default printer you wish to alter 

Update Printer 
This button actions the change selected 

 

19.3 Using the My Customisation screen 

 

19.3.1 - This "Change Colour Scheme” box shows the current background colour for the screens. If you wish to 

change this click on the box and a new window will open that allows you to select a new colour, once you click 
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OK the screen closes and the screen background colour has now been changed. If you wish to return to the 

default colour click the “Use Default” button 

 

19.3.2 - The “Set New Background” box shows the current background image. If you wish to change this click 

on the box and a new window will open asking you to select a new image (This needs to be in a BMP, GIF or 

JPG format), once you have selected the image click OPEN and the image will now have been changed. If you 

wish to return to the default background image click the “Use Default” button (This will only change back again 

once the system has ben reloaded) 

 

19.3.3 - The “Main System Scheme” is shown at the top right. You can select a new scheme using the drop 

down list. If you wish to return to the default system scheme click the “Use Default” button 

 

19.3.4 - The printers are shown at the bottom. To change these click the “Change Default Printer(s)” button 

and new options will be displayed underneath. The list of printers installed in Windows is shown on the right 

and the Radial selection to the right allows you to select which printer you wish to change. Once you have 

selected a printer and a default printer to change click the “Update Printer” button to action it (The default 

printer will now show the new printer selected). To clear the default printers click the “Clear Defaults” button 
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20. My System Alerts 

 

20.1 What this screen is used for 

 

Viewing and deleting your system alerts 

 

20.2 Understanding the screen 

 

 
 

Alerts list 
This shows the list of your alerts 

Days to Show in Calendar 
This allows you to select the number of days to view on the calendar using the up and down arrows 

Show 24Hr Calendar / Show Default Hrs 
This allows you to switch between viewing a 24Hr day and the Default Working Hrs 

Delete All Messages from Calendar 
This allows you to delete all the messages on the calendar 

Delete Selected Message from Calendar 
This allows you to deleted the selected message from the calendar 

Refresh Messages and Calendar 
This allows you to refresh the page in case there have been any changes 

Pause Auto Refresh 
This tick box allows you to pause the auto refresh on the page 

Calendar view 
This shows your alerts in a calendar view 

Mark As Read 
This allows you to mark the selected message as read 

 

20.3 Using the My System Alerts screen 

 

20.3.1 - You can view your system alerts in a list view and calendar view, to view a system alert in the calendar 

view select it from the list on the left. You can alter the number of days being viewed on the calendar view 

using the up and down arrows next to “Days to Show in Calendar”. The “Show 24Hr Calendar”/”Show Default 

Hrs” button (depending on which view you are currently in) allows you to switch between viewing the whole 

24 hours on the calendar or just the working hours 

 

20.3.2 – If you wish to mark an alert as being looked at you need to select it from the list or calendar view then 

click the “Mark As Read” . When deleting alert messages you can either, select a single alert then click the 

“Delete Selected Message from Calendar” or delete all your alerts using the “Delete All Messages from 

Calendar” button 
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21. My User Interaction 

 

21.1 What this screen is used for 

 

Viewing, deleting, sending and replying to internal messages 

 

21.2 Understanding the screen 

 

 
 

User Interactions list 
This shows the list of messages you have received 

Message Received 
This shows the selected message text 

Message to Send 
This allows you to enter text to create a new message or reply to the above message 

Delete Ticked Messages 
This allows you to delete the ticked messages 

Users 
This shows the list of users in the system, ones highlighted in blue are currently logged in 

Refresh Users 
This allows you to refresh the users list above 

Refresh Messages 
This allows you to refresh the messages list to the left 

Send to Ticked Users 
This allows you to send the entered text to the ticked users above 

Reply to Sender 
This allows you to reply to the message selected using the entered text 

 

21.3 Using the User Interaction screen 

 

21.3.1 - The main user interactions list shows all your internal messages which have been received. To view a 

message select it from the list and it will be displayed below in the “Message Received” box 

 

21.3.2 - The “Message to send” box allows you to enter a new internal message to send. To send this message 

to the current message being viewed, click the “Reply to Sender” button. If you wish to send this to a user / 

users you need to tick them in the users list then click the “Send to Ticked Users” button 

 

21.3.3 - If you wish to delete a message / messages you need to place a tick next to them in the “User 

Interactions list” then click the “Delete Ticked Messages” button 
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22. Contact Information 

 

Website address 

 

http://www.argonautsystems.com/ 

 

Argonaut Systems Ltd. 
 
C.B.T.C. Building 
Senghennydd Road 
Cardiff 
CF24 4AY 
United Kingdom 
 

 
 
Telephone number 
 
0845 643 1805 
 
Fax number 
 
029 20 647009 
 
eMail address 
 
mail@argonautsystems.com  
 
Technical Support  
 
Telephone number 
 
0845 643 1881  
 
eMail address 
 
helpdesk@argonautsystems.com 
 
 

http://www.argonautsystems.com/
mailto:mail@argonautsystems.com
mailto:helpdesk@argonautsystems.com

